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Введение

В настоящее время существует множество графических редакторов и программ 
геометрического моделирования. Компания Autodesk – один из ведущих произ-
водителей систем автоматизированного проектирования и программного обес
печения (ПО) для конструкторов, дизайнеров, архитекторов. Это крупнейший в 
мире поставщик ПО и услуг для промышленного и гражданского строительства, 
машиностроения, геоинформатики, цифровых средств передачи информации и 
беспроводной связи.

Система AutoCAD, разработанная этой компанией, является лидирующей 
среди платформ программного обеспечения систем автоматизированного проек-
тирования (САПР). Она предназначена для профессионалов, которым требуется 
воплощать свои творческие замыслы в реальные динамические проекты.

AutoCAD – программа с богатой и во многом уникальной историей. Впервые 
она увидела свет в 1982  году под именем MicroCAD. Первая версия AutoCAD 
ознаменовала начало настоящей революции в автоматизированном проектирова-
нии. Сегодня AutoCAD используют в своей работе миллионы проектировщиков 
во всем мире на процессорах в тысячи раз мощнее тех, которые были установлены 
на первых персональных компьютерах.

AutoCAD является постоянно развивающейся базовой средой проектирова-
ния. Каждая новая версия программы наследует все лучшее от предыдущих и на-
правлена на повышение производительности и эффективности работы пользова-
телей.

В версии AutoCAD 2016 компания Autodesk предлагает архитекторам, дизай-
нерам, инженерам и проектировщикам новый инструмент для еще более полного 
воплощения их идей в реальность.
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Глава 1. AutoCAD 2016. Общие сведения14

Требования к системе
AutoCAD может работать как в автономном режиме, так и в локальной сети.

Для эффективной работы 32-разрядной версии AutoCAD  2016 под управле-
нием операционной системы Windows необходимы следующие программные и 
аппаратные средства:

�� операционные системы: Windows® 8 Standard, Enterprise или Professional 
edition; Windows® 7 Enterprise, Ultimate, Professional, или Home Premium 
edition; Windows® XP Professional или Home edition (c пакетом обновле-
ний SP2 или более поздним);

�� процессор: Windows® XP – двухъядерный процессор Intel® Pentium® IV 
или AMD Athlon с тактовой частотой 1,6 ГГц или выше, с поддержкой тех-
нологии SSE2; Windows® 7 или Windows® 8  – двухъядерный процессор 
Intel® Pentium® IV или AMD Athlon с тактовой частотой не менее 3,0 ГГц, 
с поддержкой технологии SSE2;

�� браузер: Windows Internet Explorer® 7.0 или более поздний;
�� оперативная память: 2 Гбайт (рекомендуется 4 Гбайт);
�� монитор VGA с разрешением не менее 1024×768 и поддержкой режима 

True Color (рекомендуется 1600×1050);
�� жесткий диск: 6 Гбайт свободного места для установки;
�� привод компакт-дисков: DVD-ROM (для установки программы).

Для работы 64-разрядной версии AutoCAD 2016 необходимо:

�� операционные системы: все перечисленные для 32-разрядной версии 
AutoCAD 2016;

�� процессор: AMD Athlon 64, AMD Opteron™, Intel® Xeon® с поддержкой 
Intel® EM64T или Intel® Pentium® IV с поддержкой Intel® EM64T (все с 
технологией SSE2);

�� браузер: Windows Internet Explorer® 7.0 или более поздний;
�� оперативная память: 2 Гбайт (рекомендуется 4 Гбайт);
�� монитор VGA с разрешением не менее 1024×768 и поддержкой режима 

True Color (рекомендуется 1600×1050);
�� жесткий диск: 6 Гбайт свободного места для установки;
�� привод компакт-дисков: DVD-ROM (для установки программы).

Дополнительные требования к программным и аппаратным средствам, необхо-
димые для 3D-моделирования:

�� процессор: Pentium® IV или AMD Athlon c тактовой частотой 3 ГГц или 
выше; либо двухъядерный процессор Intel или AMD с тактовой частотой 
2 ГГц или выше;

�� дополнительно 6 Гбайт свободной памяти на жестком диске, необходимой 
для установки;
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�� видеоадаптер с экранным разрешением 1280×1024 с памятью не менее 
128 Мбайт, а также с поддержкой режима True Color, технологии Pixel 
Shader 3.0 или более поздней версии; графический адаптер класса рабочих 
станций с поддержкой Direct3D®.  

Запуск AutoCAD
Запуск AutoCAD осуществляется следующими способами: 

�� на Панели задач выберите из меню Start → Programs → Autodesk → Auto-
CAD 2016;

�� на Рабочем столе Windows дважды щелкните на пиктограмме AutoCAD 2016.

При запуске AutoCAD предлагает создать новый неименованный рисунок. 
Можно либо начать создавать в нем объекты, либо загрузить с диска один из уже 
имеющихся файлов.

При открытии ранее подготовленного рисунка всем системным переменным 
присваиваются значения, которые они имели в ходе последнего сеанса работы с 
ним. Это происходит благодаря тому, что переменные сохраняются в файле вместе 
с рисунком.

Если же вы начинаете работу «с нуля», следует предварительно задать ряд 
установок. Обычно это делается автоматически с помощью Мастера подготовки 
Wizard Description. AutoCAD позволяет менять установки и в ходе сеанса, если 
возникает такая необходимость.

Вызов справочной системы
В любой момент работы с AutoCAD можно получить доступ к 
электронной документации по программе. Для этого необходимо 
выбрать в падающем меню пункт Help (рис. 1.1). Альтернативный 
вариант – нажать клавишу F1 на функциональной клавиатуре или 
ввести символ ? в командной строке.

Рис. 1.1. Падающее меню справочной системы

Вызов справочной системы
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Падающее меню Help содержит следующие пункты:

�� Help – загрузка справочной системы;
�� Download Offline Help – cкачать справочную систему для работы в режиме 

вне сети:
�� Additional Resources – дополнительные ресурсы:

•	 Support Knowledge Base – база знаний службы поддержки: часто задавае
мые вопросы, сведения о последних обновлениях продукта, информа-
ция о дискуссионных группах, специальные программы поддержки 
(требуется соединение с Интернетом);

•	 Online Training Resources – ресурсы для интерактивного обучения: инфор-
мация об авторизованных учебных центрах Autodesk и прочих учебных 
центрах, сведения о сертификации, ссылки на дискуссионные группы, 
средства обучения (требуется соединение с Интернетом);

•	 Online Developer Center  – интерактивный центр разработчика: постоян-
но обновляющиеся ресурсы, содержащие ответы на вопросы, заданные 
пользователями, образцы приложений, электронную документацию 
(требуется соединение с Интернетом);

•	 Developer Help – загрузка системы документации для разработчиков;
•	 Autodesk User Group International – группы пользователей Autodesk во всем 

мире;
�� Send Feedback – обратная связь (требуется соединение с Интернетом);
�� Customer Involvement Program… – загрузка программы вовлечения пользо-

вателей Autodesk;
�� Desktop Analytics... – загрузка программы настольной аналитики;
�� About AutoCAD 2016 – загрузка информации о программе.

Открытие рисунков
Программа AutoCAD по умолчанию записывает внутреннее представление ри-
сунка в файл с расширением DWG. Кроме рисунка, файл содержит ряд парамет
ров, определяющих значения переключателей режимов шага привязки SNAP, сет-
ки GRID, ортогонального режима ORTHO; принятые единицы измерения и точность 
представления; границы рисунка; организацию слоев; форматы и логотипы; раз-
мерные и текстовые стили; типы линий и т. п.

AutoCAD предлагает многооконную среду проектирования Multiple Design 
Environment (MDE), которая допускает одновременное открытие нескольких 
чертежей. В одном сеансе работы можно открывать неограниченное количество 
рисунков, не жертвуя при этом производительностью. Среда MDE позволяет пе-
ретаскивать объекты, копировать их свойства, такие как цвет, слой, тип линии, из 
одного рисунка в другой. Она обеспечивает параллельную работу с несколькими 
рисунками, не прерывая выполнения текущей команды и не нарушая последова-
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тельности действий. Это существенно упрощает выполнение многих операций и 
повышает эффективность работы.

Открыть существующий рисунок можно с помощью команды OPEN, 
которая вызывается из падающего меню File → Open… (Ctrl+O) или щелч-
ком на пиктограмме Open… панели быстрого доступа.

После обращения к команде OPEN на экране AutoCAD появляется диалоговое 
окно выбора файла Select File (рис. 1.2). Здесь можно выбрать файл из списка или 
ввести его имя в поле File name:.

Рис. 1.2. Диалоговое окно выбора файла

При выделении в списке одного из файлов в области Preview появляется соот-
ветствующий образец рисунка. Нажатие кнопки Views выводит список, изменяя 
параметры которого, пользователь может выбрать форму представления файлов, 
предлагаемых для открытия: список, таблицу, образцы.

При нажатии стрелки справа от кнопки Open (в правом нижнем углу диалого-
вого окна) в списке устанавливается режим открытия файлов – Open (открыть), 
Open Read-Only (открыть для чтения), Partial Open (открыть частично), Partial Open 
Read-Only (открыть для чтения частично). Частичное открытие позволяет загру-
жать только те объекты рисунка, которые принадлежат определенным слоям или 
видовым экранам. Это оказывается полезным при работе с большими файлами.

Для открытия нескольких рисунков одновременно следует выбрать необходи-
мые файлы в диалоговом окне Select File, используя клавишу Shift или Ctrl.

Открытие рисунков
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Кроме того, рисунки можно открывать путем перетаскивания из Проводника 
Windows. Для этого один или несколько выделенных в дереве Проводника файлов 
следует перетащить с помощью мыши в любую часть окна AutoCAD, за исклю-
чением области рисунка, например на командную строку или в ту часть панелей 
инструментов, которая не занята кнопками. Если же перетащить один файл в об-
ласть рисования уже открытого рисунка, то произойдет вставка содержимого пе-
ретаскиваемого документа в текущий рисунок в качестве внешней ссылки.

Для открытия рисунка можно дважды щелкнуть на имени соответствующего 
файла в Проводнике Windows, что приведет к автоматическому запуску AutoCAD. 
Если же в системе уже ведется сеанс работы в AutoCAD, то рисунок откроется в 
нем.

В AutoCAD имеется специальное средство просмотра небольших фрагментов 
рисунков, открытия файлов рисунков и их поиска. Его можно использовать для 
поиска файлов в структуре папок на одном или нескольких дисках.

Для загрузки диалогового окна просмотра и поиска файлов Find, показанного 
на рис. 1.3, необходимо в диалоговом окне Select File последовательно щелкнуть на 
кнопках Tools → Find….

Рис. 1.3. Диалоговое окно просмотра и поиска файлов
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На вкладке Name & Location диалогового окна Find указываются имя, расшире-
ние и область поиска файла.

AutoCAD разрешает выполнять поиск файлов по датам их создания, пользуясь 
вкладкой Date Modified диалогового окна Find (рис. 1.4). Здесь организуется поиск 
файлов, созданных или измененных в период между двумя указанными датами 
либо за определенное количество последних дней или месяцев. Имена найденных 
документов отображаются в нижней части диалогового окна.

Рис. 1.4. Вкладка поиска файлов

Рисунки, созданные в AutoCAD любой предшествующей версии, открываются 
как любой документ версии 2016 и автоматически преобразуются в новый формат.

Создание рисунков
При создании рисунка могут использоваться различные стандарты. Иногда они 
диктуются государственными и отраслевыми стандартами или нормами предприя
тия, иногда – требованиями заказчика. Ключевой момент как для непосредствен-

Создание рисунков
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ных исполнителей, так и для руководителей групп, контролирующих ход выпол-
нения проекта, – это грамотная подготовка начальных параметров рисунка.

Рассмотрим в качестве примера архитектурный проект. Он может включать в 
себя множество разделов: планы этажей, схемы сетей водоснабжения, канализа-
ции, отопления, вентиляции и т. п. Обычно каждый раздел проекта разрабатыва-
ется в отдельном подразделении, поэтому здесь остро встает проблема унифика-
ции. Наиболее грамотное ее решение – обеспечение всех исполнителей файлами 
шаблонов, настроенными на используемую систему единиц и содержащими стан-
дартные рамку, основную надпись, слои и типы линий.

Не менее важно, какие стили применяются для текстовых надписей, штрихова-
ния и нанесения размеров. Их также следует задавать заранее: это дает гарантию, 
что каждый проектировщик будет действовать без отклонения от оговоренных 
стандартов.

Следует ответственно подходить к выбору рабочего масштаба. Только четкое 
представление о том, как соотносятся единицы рисунка на экране и единицы чер-
тежа, выводимого на плоттер, позволяет правильно выбрать высоту текста для по-
яснительных надписей и размеров.

Хотя компоновка чертежа обычно производится на последних стадиях проек-
тирования, грамотное планирование на предварительных этапах позволяет избе-
жать многих ошибок и избавить персонал от излишних операций редактирования. 
При создании проекта работа, как правило, ведется в пространстве модели (здесь 
объекты представляются в натуральную величину), а для компоновки чертежа 
выполняется переход в пространство листа, где ко всем графическим объектам, 
текстам, типам линий и размерам применяется необходимый масштабный коэф-
фициент.

Все начальные установки рисунка могут быть сохранены в шаблоне для по-
следующего использования в других документах. В качестве шаблона могут 
применяться как рисунки, поставляемые с AutoCAD, так и любые другие, в том 
числе созданные пользователем. Новый рисунок наследует всю информацию из 
используемого шаблона. Имеется также возможность запускать AutoCAD без 
шаблона.

Создать новый рисунок позволяет команда New, вызываемая из 
падающего меню File → New... (Ctrl+N) или щелчком на пиктограмме 
New панели быстрого доступа.

После запуска команды открывается диалоговое окно выбора шаблона Select 
tamplate (рис.  1.5) (в том случае, если значение системной переменной STARTUP 
установлено в 0).

Если значение системной переменной STARTUP установлено в 1, то после запу-
ска команды New выводится диалоговое окно создания нового рисунка Create New 
Drawing  (рис. 1.6), где производятся необходимые настройки параметров рабочей 
среды AutoCAD.
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Рис. 1.5. Диалоговое окно выбора шаблона

Рис. 1.6. Диалоговое окно создания нового рисунка

Создание рисунков
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При создании рисунка по простейшему шаблону используется пикто-
грамма Start from Scratch. В данном режиме устанавливается британ-
ская или метрическая система единиц. Значения многих системных 
переменных, принятые по умолчанию, зависят от того, какая из двух 

систем выбрана. Эти переменные управляют текстом, размерами, сеткой, ре-
жимами привязки, а также устанавливают действующие по умолчанию тип 
линий и файл образцов штриховки:

�� Imperial (feet and inches)  – создается рисунок, использующий британскую 
систему единиц измерения (футы и дюймы), по шаблону acad.dwt. При 
этом область рисования, иначе называемая лимитами рисунка, устанавли-
вается равной 12×9 дюймов;

�� Metric – создается рисунок, где используется метрическая система единиц 
измерения (миллиметры), по шаблону acadiso.dwt. При этом устанавли-
вается область рисования 429×297 мм.

Чтобы создать рисунок с использованием шаблона, документа, уста-
новки которого используются как основа для нового рисунка, необхо-
димо в диалоговом окне Create New Drawing щелкнуть на пиктограмме 
Use a Template и в списке Select a Template: указать нужный шаблон, 
содержащий необходимые установки черчения (рис.  1.7). В списке 
перечисляются имена файлов шаблонов с расширением DWT, кото-
рые найдены по стандартному пути, заданному в диалоговом окне на-
строек Options. В шаблонах определяются различные параметры ри-
сунка, в том числе наборы специально созданных слоев, типов линий 
и видов;

Рис. 1.7. Выбор шаблона рисунка
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В AutoCAD имеется так называемый Мастер подготовки Wizard – служебное 
средство для создания нового рисунка. С помощью Мастера подготовки можно, 
взяв за основу текущий шаблон, модифицировать некоторые базовые установки. 
Например, пользователь может автоматически настраивать масштабные коэффи-
циенты для текста в зависимости от общих размеров рисунка. Если рисунки круп-
ные, выбирается большая высота символов, если мелкие  – меньшая; таким об-
разом обеспечивается разборчивость текстовых надписей, когда рисунок отобра
жается на экране целиком.

Для вызова Мастера подготовки необходимо в диалоговом окне Create 
New Drawing щелкнуть на пиктограмме Use a Wizard – откроется окно, 
показанное на рис. 1.8.

Рис. 1.8. Создание нового рисунка с помощью Мастера подготовки

Мастер быстрой подготовки QuickSetup (рис. 1.9) позволяет задать для ново-
го рисунка единицы измерения Units и область рисования Area. Поддерживаются 
следующие типы единиц для рисования и вычерчивания: десятичные – Decimal, 
инженерные – Engineering, архитектурные – Architectural, дробные – Fractional, на-
учные – Scientific.

Далее, указывая ширину Width и длину Length области рисования, пользователь 
тем самым задает граничные пределы рисунка, так называемые лимиты. Именно 
лимитами определяется размер чертежа, впоследствии выводимого на плоттер. 
После того как все параметры заданы, Мастер быстрой подготовки запускает се-
анс рисования в пространстве модели.

Создание рисунков
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